
In T3’s annual Gadget Awards, Apple products grabbed honors for iPhone (“Most Anticipated 
Gadget of 2007”), MacBook Pro (“Drop Dead Gorgeous Award”), the iTunes Store (“Best Down-

load Service”), and in a Gadget Awards hat trick, iPod scored in the “Top Commuter Gadget,” “Best Music Gadget,” and the “Best Gadget of All Time” 
categories. View at http://competition.futurenet.com/t3awards
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NEXT MEETING:
Wednesday 

November 14, 2007
in Burlington

6:30 pm

Our Speaker will be

Michael
Gill

talking about

Managing
the

Company
Network 

NEXT EXECUTIVE MEETING
November 19, 2007 at 

Creative Technology 

A Message from the President

APPLE in the NEWS

Last month we all met at Advantage Signs 
in Burlington. Jeff  Beaton showed off 

what they can print and we had a look at the 
$300,000.00 printer that can print up to 6 feet 
wide. Advantage Signs does all my signs and 
banners and is also a customer of mine.
This past month has been wild with the final 
release of the next Mac operating system, 
Leopard, OS 10.5. Sales have been great, the 
only problem is in getting the boxes. I have 
had a chance to use Leopard and I like the 
new functionality. The look of it is taking some 
getting used to though. Apple has added 300 
new items to it, some you will see, and some you 
won’t. It is fast though, and I really love the back 
to my Mac function and Time machine. With the 
new iLife and leopard you really gain a lot out 
of it if you have a dotmac account. I have had 
a dotmac account now for about 4 years and 
it really takes time to learn how to use it to its 
full potential. Now Apple has lowered the price 
to $109.00 from $139.00. If you have dotmac 
and would like to renew your subscription we 
are offering a $10.00 discount on the cost. So 
it would end up at the same price as the US 
$99.00.
Some of Apples products are now on par with 
the US, iLife, iWork, and Leopard, but hardware 
is still way off. Even the new MacBooks did not 

see any price correction. 
My account assistant at 
Apple says to be patient, 
they are working on it. 
All of the computers and 
iPods I order come strait 
from China, and I pay 
Apple in Canadian dollars. 
My price has not changed 
at all. So I would like to 
know, who is making all 
the money. If you read 
Apples quarterly reports 
you know the answer to 
that question. I would hope we get a price correction soon 
as the Christmas season is fast approaching and I know 
people are making the trek to Buffalo.
This month we welcome Bruce McGee from Paradigm 
Electronics. Bruce is also one of my customers, but he is also 
a neighbor of Alan Adams. So Alan is the one responsible for 
getting Bruce to come out to the club. Bruce is going to talk 
about how they manage their company network. You can 
also have a look at the new Leopard OS 10.5
Once again the December meeting will be held at Carolines 
house. We don’t have a date yet but stay tuned and it will be 
in the next HACKette.

See you all this Wednesday
Dave

3480 Fairview St.

Guelph Line Walkers Line

W        Q.E.W.         E The Apple Macintosh User Group of Hamilton is a non-profit organization 

that meets informally at 6:30 PM, the second Wednesday of each month 

at: Creative Technology, 3480 Fairview St., Burlington.

This group is made up of users of the Apple Macintosh family of personal 

computers, whose interests range from word processing to publishing, 

music and games, art to accounting and often times to 

formal presentations or more. Our main purpose is to 

provide a forum for questions, solutions and inspiration for 

everyday computing. 

For more information about the user group, please attend 

the next Club meeting, contact a member of the executive, 

or visit our web site: www.hamiltonmacintosh.com

For more info, go to:
mapquest.com
type location:

3480 Fairview St.,
Burlington, ON



lots of questions 
and Jeff came up 
with the answers 
and more.
Many thanks to 
Jeff for his time 
and effort.
You can forward 
referrals to Jeff at 
www.advantage-
signs.ca or call him 
at 905-634-6811 or 
1-800-205-7446 (toll free).

Last month the HACK meeting took place 
at Ad-Vantage Signs, 4391 Harvester Rd., 

Burlington. On the front cover of the HACKette 
was a map and address to the wrong place. 
Somehow the error crept in and was not caught 
until the last minute. Alan Adams quickly sent 
out multiple e-mails correcting the location 
address. As I have stressed in the past, be sure 
to check your e-mail incase of last minute 
changes. Do as I say, NOT as I do!!
I arrived late to find more than a dozen 
members already in attendance. We listened to 
Jeff Beaton talk about the many aspects of his 
work, many of the posters, signs and banners 
on the wall plus the acquisition of a $350,000 
Vutek 2000 printer.

We moved into the design area of the office 
where we looked at a large format printer that 
had about six ink cartridges each about the size 
of cigarette cartons. There was also an iMac and 
a tower Mac with a very large monitor (provides 
the “wow” factor for presentations). The PC was 
there for those who send in files done in Corel 
or Office programs. We moved on into the next 
room to view some samples of signs done on 
clear plastic and cling film. The Vutek printer 
can print white ink and the advantage comes 
when the image is printed on the inside surface 
then a white layer is applied over that one, and 
finally the same image is printed on top of the 
white layer. This happens all at once so the 
images stay in register. The resulting sign face 

will now appear 
the same during 
daylight hours as 
it does at night. To 
show this effect, 
Jeff moved us 
all back into the 
previous room 
where he turned 
on the ceiling 
lights to simulate 
daylight. We 

observed the picture on the wall. He then 
turned off the lights and turned on the lights 
behind the picture. The picture appeared very 
similar to the front lit version. An effect that 
cannot be duplicated by simply putting a single 
picture onto the inside surface of plastic (which 
acts as a protective layer).
Now we moved back into the big room for 
a closer look at the Vutek 2000. For detailed 
specifications, go to www.efi-vutek.com. At 

the web site look for the 
Vutek QS 2000 and follow 
the links.
I am not going to complain as much about 
refilling my ink cartridges after seeing the 
Vutek that has six 3.25 liter boxes of coloured 
inks plus the white! Nor am I going to complain 
about maintenance. The Vutek, when doing 
numerous jobs in succession, needs to have 
the print head cleaned every couple of hours, 
then special care before leaving for the night. 
Seasonal changes requires special care due to 
dry air static in winter and summer humidity. 
The seasonal changes also effects the handling 
characteristics of the print material so constant 
vigilance is required. You can easily understand 

why training and 
experience plays such 
an important roll in this 
print process. 
Jeff mentioned the 
largest job was an eight 
by ninety foot banner 
for a mall display. The 
longest job took three 
days (and nights) 
straight which did NOT 
include sleep. Time is of 
the essence and it is also the most demanding. 
The production department usually get the 
least amount and like most industries, jobs 
always arrive just before the long week end and 
have to be done yesterday.
Next, we toured around the shop for a close up 
look at some of the work that was in process. 
(None of the printers were running during the 
tour ) We were amazed at the clarity of the 
prints and the printing resolution. We asked 

EDITOR’S NOTES

Editor: Jim Auty

2 HACKette Nov 2007



Saturday, October 20th, Tyler and I set out once 
again for a seminar in Toronto. We allowed our 
standard two hour lead time to ensure getting 
to the iPod + iTunes Workshop and Listening 
Party seminar held at CPUsed  (488 Dupont 
Street (west of Bathurst), Toronto, ON M6G 1Y7  
416-533-2001). This location was not all that far 
from the Computer Systems Centre (Collage & 
Avenue Rd.) we were at for the Make Music With 
Garageband seminar  back on September 29.
 Some how we beat the breakfast crowd into 
the big city so we headed to the Golden Arches 
for take-out Egg McMufffins, coffee and juice. 
We ate them in the CPUsed parking lot and still 
had time to spare to cruise the aisles of their lo-
cation. What a temptation that was. There were 
several computers setup for sampling and a 
black MacBook Pro with an attached large sec-
ond monitor that really caught my eye. They 
would not take my K-car as a trade.
For the seminar, Steve Schaltz took us down-
stairs to the presentation room where we met 
the presenter, Jim Parsons. After intros, Jim gave 

a description of his impressive background then 
started into the first phase, file formats. This was 
somewhat dry but essential. The reason you can 
load so many MP3 files onto a player is because 
of their higher compression and somewhat 
lower quality 
level. When you 
have your player 
blasting into 
your ears while 
you sort glass 
bottles in the 
back of a pick-up 
truck in heavy 
traffic, the sound quality will not matter much. 
When you plug your iPod into your home sur-
round sound system, you will want the larger, 
high quality file formats that compete with CD 
quality. That is why high quality sound can gob-
ble up to eight times the space of MP3 files (and 
are not traded on the Internet like MP3s). This is 
why file format matters and can have a bearing 
on which iPod will work for you. Jim covered a 
lot of information and a printed handout would 
have been a big help especially if it included 
some details of the following.
Phase two was about working with iTunes itself. 
Much of the everyday workings was skipped 
assuming we had at least done that much 
ourselves. Jim and Steve covered preferences 
that should be used for higher quality imports 
of your own CDs. You can easily find these in 
Preferences under the iTunes title in the menu 

SEMINAR REVIEW bar. We were more 
excited about how to 
get album art after 

you have imported old CDs or cuts from your 
cassettes or vinyl. Recordings from cassettes 
or vinyl will probably 
need to be manually 
named and saved. The 
next step is to have 
iTunes open and the 
desired song select-
ed. Press Command-I 
(File > Get Info) and a 
dialogue box appears. 
Choose Artwork from 
the menu bar. Keep 
this dialogue box off 
to one side while you 
go off to Amazon.
com. Once there, enter the name of your album 
in the search area. The result (keep your fingers 
crossed) will have 
a small picture of 
the desired album 
art. Double click on 
it to go to a page 
about it. Directly 
underneath the al-
bum cover picture 
should be a line that 
says See Larger Im-
age. Go there by se-
lecting and double 
clicking on that line. 
Now click on the 
picture, hold and drag it from there onto your 
Album Art dialogue box (1, 2 ,3). A green circle 
with a white plus sign will appear momentarily 
and that is when you can release the album art 
into the dialogue box. Some album art is small 
and will have a white perimeter while most are 
large and will fill the album art box, top to bot-
tom. Some album pages have multiple choices 
for album art so 
be sure to check 
for the largest and 
best in appear-
ance. Album art 
can be deleted 
from the dialogue 
box and replaced 
as required. Now 
that iTunes looks 
great, Jim and Steve had more tips to keep your 
tunes sorted and safe.
Storing your tunes on your hard drive along 
with everything else can be risky and or space 
consuming. Keeping your tunes on an external 
hard drive will help with space. Keep only a few 
favourites on your computer. To access the ex-
ternal hard drive, ensure it is attached to your 
laptop (computer), go into iTunes(7) > Prefer-
ences > General > iTunes Music folder Location > 
Change. Locate your external Hard drive. iTunes 
will now look here for your music. When you 
are creating music or recording songs of your 
friends, you can add comments to keep track of 
what is whose. Go View > Options (Command-

J) and check the appropriate box(es). In Com-
ments you can write text as if writing code to 
keep things in a special order if needed. You can 
use unique names to sort easier. To access the 
comments box, find and select the appropriate 
song and File > Get Info (Command-I), choose 
Info on menu, enter the info in the comment 
area. While in this dialogue box, go to Options 
in the menu, and then down to My Rating. You 
can rate your music from zero to five stars. Do 
this to sort through a large number of songs 
to get just the best or worse by sorting by Rat-
ing or by Comments. Sorting? Sorting is simply 
done in iTunes by clicking on a desired column 
title above your songs.
We were now at the touchy-feelly phase of the 
presentation. We got to hold and hear the new 
iPod Nano and iTouch as well as try a pair of 
high end ear phones. This is when we got to see 
video on the iPod. 
You can take your DVD home movies and con-

vert them for viewing 
on the iPod. There are 
a couple of free down-
load programs from 
the Internet that will do 
this for you. I preferred 
Handbrake over iSquint 
and was able to put The 
Goonies into a 1.2GB 
MP4 format, import it 
into iTunes and upload 
onto Tyler’s iPod. Other 
recommended pro-
grams are HiJack Pro 

and QuickTime Pro.
You can view more by Jim Parsons at beamecho.
com/bytes. Steve, who is also an award winning 
comedian, can be found at Stevesmells.com. 
CPused has a name change to BeamEcho. They 
are also moving from 488 DuPont to 26 Cum-
berland being in mid November.
Seminar rating by Jim and Tyler. Parking and 

store: Great— we parked 
in their lot. In store we  
had sales people ask-
ing if we needed info 
on the things we were 
looking at (not common 
in many stores today). 
Seminar space: Great— 
in a room separate from 
store sounds and actions 

so presenter could be seen and heard easily, 
seating for 25 or more, large 42” screen moni-
tor for easy viewing, hands on items related to 
topic. Speaker(s): Very Good — took a while 
with definitions at start but got us interested 
with questions about opinions or what we did 
or wanted from iPod and iTunes, demonstrated 
items when questioned. Purchases made be-
cause of seminar: iLife8 and iTalk for the iPod. 
iLife because it was there and iTalk because 
now we can record ourselves onto the iPod in 
preparation for a presentation or just recording 
notes about an event or topic. 

Editor: Jim Auty
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NEWS

When attemding the 2007 Brant United Way 
Airshow, I purchased a program, Vibrant, 
LifeStyle Culture. On page 4 was WrayAnderson 
who has IC SuperComputers on the Six nations 
Reserve, Highway 54 in Oshweken. 
For more info, visit www.icnme.com

When purchasing some Ti-Cats game tickets, I 
asked why she (Cashier) was not using the iMac 
sitting beside what looked like a much older 
style computerized cash register.
“Oh, that’s only for sales of in store items.”
I asked what software was being used and she 
showed a very brief overview of LightSpeed2.
Later that evening, I checked the Internet and 
sure enough, there was a web site where I could 
download a sample version to test drive on my 
Apple computer! I am not an expert on this type 
of software and this review is just a general 
observation. Go to: www.xsilva.com/features.
php for more info and download a trial version 
for yourself evaluation to determine if it would 
be applicable to your needs.
From the web site:
LightSpeed 2 is a ground-breaking, next-
generation Point of Sale system built exclusively 
for the Mac and designed expressly to accelerate 
growing small businesses. LightSpeed excels in 
retail environments, providing your store with a 
full set of easy-to-use retail tools that make it easy 
to operate and track all aspects of your business.
LightSpeed presents these tools in an easy-to-
learn iTunes-like Browser and an innovative 
‘floating’ Point of Sale interface designed for high-

LightSpeed2

speed, error-free checkout. LightSpeed’s tightly-
integrated Web Store module (sold separately) 
can help you take your business online and 
download orders right back into LightSpeed. All 
of this functionality is built on a solid, multi-user 
database that will scale to satisfy the needs of 
your growing retail business.
If you’re opening a retail store or business, or 
currently operate one, we invite you to download 
LightSpeed 2, sign up for a free Webinar, view our 
training videos, and envision a new way of doing 
business on your Mac!
I found it to be ladden with features that were 
readily accessible and not all that foriegn to me. 
From what I was able to do, I think that scrolling 
through a long list of products in stock may get 
a little tiresome after a lot of sales (especially 
if I worked for someoone rather than being the 
store owner). What happens when your store 
blossoms and you carry a hundred lines of 
products with hundreds of different products 
in each line?
I am sure a bit of work is required to get 
information into the system for the controls you 
would want for inventory, sales and customer 
info. The ability have a product serial number 
and its picture show up on invoices means 
that info had to be input. Imagine being the 
guy in the back room photographing products 
and aligning them to serial numbers so a clerk 
could recognize what she is selling. It all has 
pros and cons but where can you get pictures of 
purchases on an invoice to show your Insurance 
guy what  those bad  guys took during that 
break-in?
When looking up stuff, you are also shown 
inventory quantity. If none of your stuff has 
grown legs, you can be up-to-date with what 
you have to sell. On the other hand, you can 
quickly check what should be in stock to your 
actual counts. This is great for spot checks and 
keeping “leg-growth” in check. New staff can 
check the on-screen photo to what is being 
presented for purchase. 
I had over 45 screen captures that I was going 
to present to you. Going to that extent and 
being able to write a very comprehensive 
review should come with an “gratis” version or 
a position on their sales team. For now, I will list 
some of the reports available (get a trial version 
for lots more info):
Intelligence: Top Customers by Revenue; 

Top Products by Profit; 
Commission by Profit 
Reports; Accounts 
Receivable (by Customer 
with their balance) ; 
Customer List (Info); 
Products (Part Number, 
Description, Sell $$, 
Inventory); Invoices; 
Privileges Setup; Transfer 
Inventory; and on and on 
and on!! 
CT is listed as a point 
of purchase for this 
software!!
CHECK IT OUT!!


